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Overview

Feather is the new development board from Adafruit, and like it's namesake it is thin, light, and lets you fly!
We designed Feather to be a new standard for portable microcontroller cores.
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At the Feather MO's heart is an ATSAMD21G18 ARM Cortex MO processor, clocked at 48 MHz and at 3.3V
logic, the same one used in the new Arduino Zero (http://adafru.it/2843). This chip has a whopping 256K of
FLASH (8x more than the Atmega328 or 32u4) and 32K of RAM (16x as much)! This chip comes with built in
USB so it has USB-to-Serial program & debug capability built in with no need for an FTDI-like chip.
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To make it easy to use for portable projects, we added a connector for any of our 3.7V Lithium polymer
batteries and built in battery charging. You don't need a battery, it will run just fine straight from the micro
USB connector. But, if you do have a battery, you can take it on the go, then plug in the USB to recharge.
The Feather will automatically switch over to USB power when its available. We also tied the battery thru a
divider to an analog pin, so you can measure and monitor the battery voltage to detect when you need a
recharge.

Here's some handy specs!

Measures 2.0" x 0.9" x 0.28" (51Tmm x 23mm x 8mm) without headers soldered in
Light as a (large?) feather - 4.6 grams

ATSAMD21G18 @ 48MHz with 3.3V logic/power

256KB of FLASH + 32KB of RAM

32.768 KHz crystal for clock generation & RTC

3.3V regulator with 500mA peak current output

USB native support, comes with USB bootloader and serial port debugging
You also get tons of pins - 20 GPIO pins

Hardware Serial, hardware 12C, hardware SPI support

PWM outputs on all pins

6 x 12-bit analog inputs

1x10-bit analog output (DAC)

Built in 100mA lipoly charger with charging status indicator LED

Pin #13 red LED for general purpose blinking

Power/enable pin

4 mounting holes

Reset button

The Feather MO Basic Proto has some extra space left over, so we give you a tiny little prototyping area. If
you just need to attach a button or sensor, you may be able to skip out on a breadboard and wire it
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directly on there.

Comes fully assembled and tested, with a USB bootloader that lets you quickly use it with the Arduino IDE.
We also toss in some header so you can solder it in and plug into a solderless breadboard. Lipoly battery
and USB cable not included (but we do have lots of options in the shop if you'd like!)
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Pinouts
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The Feather MO Basic is chock-full of microcontroller goodness. There's also a lot of pins and ports. We'll
take you a tour of them now!
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GND - this is the common ground for all power and logic

BAT - this is the positive voltage to/from the JST jack for the optional Lipoly battery

USB - this is the positive voltage to/from the micro USB jack if connected

EN - this is the 3.3V regulator's enable pin. It's pulled up, so connect to ground to disable the 3.3V
regulator

3V - this is the output from the 3.3V regulator, it can supply 500mA peak

Logic pins

This is the general purpose I/0 pin set for the microcontroller.
All logic is 3.3V

Nearly all pins can do PWM output

All pins can be interrupt inputs

® #0/RX-GPIO #0, also receive (input) pin for Serial1l (hardware UART), also can be analog input
® #1/TX - GPIO #1, also transmit (output) pin for Serial1, also can be analog input
® #20/SDA - GPIO #20, also the 12C (Wire) data pin. There's no pull up on this pin by default so when

using with 12C, you may need a 2.2K-10K pullup.
#21/ SCL - GPIO #21, also the 12C (Wire) clock pin. There's no pull up on this pin by default so when
using with 12C, you may need a 2.2K-10K pullup.

® #5-GPIO #5
® #6 - GPIO #6
® #9 - GPIO #9, also analog input A7. This analog input is connected to a voltage divider for the lipoly

battery so be aware that this pin naturally 'sits' at around 2VDC due to the resistor divider

#10 - GPIO #10

#11 - GPIO #11

#12 - GPIO #12

#13 - GPIO #13 and is connected to the red LED next to the USB jack

AO - This pin is analog /nput AO but is also an analog oufput due to having a DAC (digital-to-analog
converter). You can set the raw voltage to anything from O to 3.3V, unlike PWM outputs this is a true
analog output

® A1thru A5 - These are each analog input as well as digital I/O pins.
® SCK/MOSI/MISO (GPIO 24/23/22)- These are the hardware SPI pins, you can use them as everyday

GPIO pins (but recommend keeping them free as they are best used for hardware SPI connections for
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high speed.

Other Pins!

® RST - this is the Reset pin, tie to ground to manually reset the AVR, as well as launch the bootloader
manually
® ARef - the analog reference pin. Normally the reference voltage is the same as the chip logic voltage

(3.3V) but if you need an alternative analog reference, connect it to this pin and select the external
AREF in your firmware. Can't go higher than 3.3V!
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® SWCLK & SWDIO - These pads on the bottom are used to program the chip. They can also be
connected to an SWD debugger.
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Assembly

We ship Feathers fully tested but without headers attached - this gives you the most flexibility on choosing
how to use and configure your Feather

Header Options!

Before you go gung-ho on soldering, there's a few options to consider!

The first option is soldering in plain male headers, this lets you
plug in the Feather into a solderless breadboard
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Another option is to go with socket female headers. This won't
let you plug the Feather into a breadboard but it will let you
attach featherwings very easily

We also have 'slim' versions of the female headers, that are a
little shorter and give a more compact shape

-g;?;i -iaai,i,ti.?;i.l Ex s = fi e 3
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Finally, there's the "Stacking Header" option. This one is sort
of the best-of-both-worlds. You get the ability to plug into a
solderless breadboard and plug a featherwing on top. But its a
little bulky

Soldering in Plain Headers
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Siiisissssasassassssasiasassass  Prepare the header strip:

° N suasasssssessssssssssssssssss~ Cutthe strip tolength if necessary. It will be easier to solder if
%:5:555555555251 you insert it into a breadboard - long pins down
Bt R
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==+:Add the breakout board:

Place the breakout board over the pins so that the short pins
poke through the breakout pads

And Solder!

Be sure to solder all pins for reliable electrical contact.
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You're done! Check your solder joints visually and continue
- onto the next steps
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Soldering on Female Header

Tape In Place
For sockets you'll want to tape them in place so when you flip

over the board they don't fall out
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' B0000000 : Flip & Tack Solder

After flipping over, solder one or two points on each strip, to

'tack' the header in place
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And Solder!

Be sure to solder all pins for reliable electrical contact.
Featrer M@ WiFi

® ¢CATINC1508)
Gig
33u (For tips on soldering, be sure to check out our Guide to
: Excellent Soldering (https://adafru.it/aTk)).

L]
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You're done! Check your solder joints visually and continue
onto the next steps
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Power Management

Battery + USB Power

We wanted to make the Feather easy to power both when connected to a computer as well as via battery.
There's two ways to power a Feather. You can connect with a MicroUSB cable (just plug into the jack) and
the Feather will regulate the 5V USB down to 3.3V. You can also connect a 4.2/3.7V Lithium Polymer
(Lipo/Lipoly) or Lithium lon (Lilon) battery to the JST jack. This will let the Feather run on a rechargable
battery. When the USB power is powered, it will automatically switch over to USB for power, as well as
start charging the battery (if attached) at 100mA. This happens 'hotswap' style so you can always keep
the Lipoly connected as a 'backup' power that will only get used when USB power is lost.

The JST connector polarity is matched to Adafruit LiPoly batteries. Using wrong polarity batteries can
destroy your Feather

000000
WS" S5 SCL20a

£00000000
?

00000000
00000000
%x

20-0-0-0 N0
i RX@TX:
50008

The above shows the Micro USB jack (left), L|ponJST jack (top Ieft) as well as the 3.3V regulator and
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changeover diode (just to the right of the JST jack) and the Lipoly charging circuitry (to the right of the
Reset button). There's also a CHG LED, which will light up while the battery is charging. This LED might
also flicker if the battery is not connected.

The charge LED is automatically driven by the Lipoly charger circuit. It will try to detect a battery and
is expecting one to be attached. If there isn't one it may flicker once in a while when you use power
because it's trying to charge a (non-existant) battery. It's not harmful, and its totally normal!

Power supplies

You have a lot of power supply options here! We bring out the BAT pin, which is tied to the lipoly JST
connector, as well as USB which is the +5V from USB if connected. We also have the 3V pin which has the
output from the 3.3V regulator. We use a 500mA peak regulator. While you can get 500mA from it, you
can't do it continuously from 5V as it will overheat the regulator. It's fine for, say, powering an ESP8266
WiFi chip or XBee radio though, since the current draw is 'spikey' & sporadic.

. (ﬂ
SB1347 11718 S ps ‘5 SCLSDﬁ
gdatruit? O-O-O-O

3.3V

!OOOOOOO

MR CHGR . =
N
RS'ESUﬂPTGNDﬁG—ﬂi

o
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9
5

Measuring Battery

If you're running off of a battery, chances are you wanna know what the voltage is at! That way you can tell
when the battery needs recharging. Lipoly batteries are 'maxed out' at 4.2V and stick around 3.7V for
much of the battery life, then slowly sink down to 3.2V or so before the protection circuitry cuts it off. By
measuring the voltage you can quickly tell when you're heading below 3.7V

To make this easy we stuck a double-100K resistor divider on the BAT pin, and connected it to D9 (a.k.a
analog #7 A7).
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In Arduino, you can read this pin's voltage, then double it, to get the battery voltage.

// Arduino Example Code

#define VBATPIN A7

float measuredvbat = analogRead(VBATPIN);

measuredvbat *= 2;
measuredvbat *= 3.3;
measuredvbat /= 1024;
Serial.print("VBat: "

// we divided by 2, so multiply back

// Multiply by 3.3V, our reference voltage
// convert to voltage

); Serial.println(measuredvbat);

For CircuitPython, we've written a get_voltage() helper function to do the math for you. All you have to do
is call the function, provide the pin and print the results.

import board
import analogio

vbat voltage = analogio.AnalogIn(board.D9)

def get voltage(pin):

return (pin.value * 3.3) / 65536 * 2

battery voltage = get voltage(vbat voltage)

print("VBat voltage: {:

ENable pin

.2f}" . format(battery voltage))

If you'd like to turn off the 3.3V regulator, you can do that with the EN(able) pin. Simply tie this pin to
Ground and it will disable the 3V regulator. The BAT and USB pins will still be powered
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Alternative Power Options

The two primary ways for powering a feather are a 3.7/4.2V LiPo battery plugged into the JST port ora
USB power cable.

If you need other ways to power the Feather, here's what we recommend:

® For permanent installations, a 5V 1A USB wall adapter (https://adafru.it/duP) will let you plug in a USB
cable for reliable power

® For mobile use, where you don't want a LiPoly, use a USB battery pack! (https://adafru.it/e2q)

® |f you have a higher voltage power supply, use a 5V buck converter (https://adafru.it/DHs) and wire it
to a USB cable's 5V and GND input (https://adafru.it/DHu)

Here's what you cannot do:

® Do not use alkaline or NiMH batteries and connect to the battery port - this will destroy the LiPoly
charger and there's no way to disable the charger
® Do not use 7.4V RC batteries on the battery port - this will destroy the board

The Feather /s not designed for external power supplies - this is a design decision to make the board
compact and low cost. It is not recommended, but technically possible:

® Connect an external 3.3V power supply to the 3V and GND pins. Not recommended, this may cause
unexpected behavior and the EN pin will no longer. Also this doesn't provide power on BAT or USB
and some Feathers/Wings use those pins for high current usages. You may end up damaging your
Feather.

® Connect an external 5V power supply to the USB and GND pins. Not recommended, this may cause
unexpected behavior when plugging in the USB port because you will be back-powering the USB
port, which could confuse or damage your computer.
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Arduino IDE Setup

The first thing you will need to do is to download the latest release of the Arduino IDE. You will need to be
using version 1.8 or higher for this guide

https://adafru.it/fIP

https://adafru.it/f1P

After you have downloaded and installed the latest version of Arduino IDE, you will need to start the
IDE and navigate to the Preferences menu. You can access it from the File menu in Windows or Linux, or
the Arduino menu on OS X.

" a
Blink | Arduino 1.8.2 [ESREER )
Edit Sketch Tools Help

MNew Ctrl+MN

Open... Ctrl+0

Open Recent r

Sketchbook r i
Examples ko I e e
Clase Ctrl+W I N . ) S
Save Ctrl+S

Save As... Ctrl+Shift+5

Page Setup  Ctrl+5Shift+P

Print Ctrl+P
Preferences  Ctrl+Comma

Quit Ctrl+Q

A dialog will pop upjust Iiké the one shown below.
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[ ] Preferences

Sketchbook location:
/Users /todd/Documents /Arduino

Editor language: = System Default

Editor font size: 10 (requires restart of Arduino)
Show verbose output during: compilation upload
Compiler warnings: = None H

Display line numbers
v Verify code after upload
Use external editor
v Check for updates on startup
v Update sketch files to new extension on save (.pde -> .ino)

v save when verifying or uploading

Proxy Settings

Server (HTTP): Port (HTTP): 8080
Server: (HTTPS) Port (HTTPS): 8443
Username: Password:

Additional Boards Manager URLs: |

More preferences can be edited directly in the file
/Users /todd/Library/Arduinol5/preferences.txt
(edit only when Arduino is not running)

.
-

Browse

(requires restart of Arduino)

oK Cancel

We will be adding a URL to the new Additional Boards Manager URLs option. The list of URLs is comma
separated, and you will only have to add each URL once. New Adafruit boards and updates to existing
boards will automatically be picked up by the Board Manager each time it is opened. The URLs point to
index files that the Board Manager uses to build the list of available & installed boards.

To find the most up to date list of URLs you can add, you can visit the list of third party board URLs on the
Arduino IDE wiki (https://adafru.it/f7U). We will only need to add one URL to the IDE in this example, but
you can add multiple URLS by separating them with commas . Copy and paste the link below into

the Additional Boards Manager URLs option in the Arduino IDE preferences.

https://adafruit.github.io/arduino-board-index/package adafruit_index.json
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T L s

Settings | Network

Sketchbook location:

C:\WsersYadyada'\Dropbox\ArduinoSketches
Editor language: :Syshem Default - (requires restart of Arduino)

Editor font size: 12

Interface scale: Automatic | 100 % (requires restart of Arduing)

Show verbose output during: compilation upload

Compiler warnings: Mone w

[ Display line numbers i
[ Enable Code Folding

Verify code after upload

[] Use external editor

Check for updates on startup

Update sketch files to new extension on save (.pde -> .ino)

Save when verifying or uploagi
Additional Boards Manager URLs:f |https: f{adafruit.com/package_adafruit_index.json
Mare preferences can be edited directly in the file

| Enter a comma separated list of urlsl
C:\UsersVadyada\AppDataiLocal\Arduino 15 preferences. bt f

(edit only when Arduine is not running) i

Here's a short description of each of the Adafruit supplied packages that will be available in the Board
Manager when you add the URL:

e Adafruit AVR Boards - Includes support for Flora, Gemma, Feather 32u4, Trinket, & Trinket Pro.

® Adafruit SAMD Boards - Includes support for Feather MO and M4, Metro MO and M4, ItsyBitsy MO and
M4, Circuit Playground Express, Gemma MO and Trinket MO

® Arduino Leonardo & Micro MIDI-USB - This adds MIDI over USB support for the Flora, Feather 32u4,
Micro and Leonardo using the arcore project (https://adafru.it/eSl).

If you have multiple boards you want to support, say ESP8266 and Adafruit, have both URLs in the text
box separated by a comma (,)

Once done click OK to save the new preference settings. Next we will look at installing boards with the
Board Manager.

Now continue to the next step to actually install the board support package!
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Using with Arduino IDE

The Feather/Metro/Gemma/QTPy/Trinket MO and M4 use an ATSAMD21 or ATSAMD51 chip, and you can
pretty easily get it working with the Arduino IDE. Most libraries (including the popular ones like NeoPixels
and display) will work with the MO and M4, especially devices & sensors that use [12C or SPI.

Now that you have added the appropriate URLs to the Arduino IDE preferences in the previous page, you
can open the Boards Manager by navigating to the Tools->Board menu.

[ sictch_nov27a | Ardu S TEE———

File Edit Sketch ETools Help

Auto Format
Archive Sketch
Fix Encoding & Reload

1 |void setug Serial Monitor Ctrl+Shift+ M

sketch_noviTe

2 /) put ¥

3 Board: "Arduino/Genuino Uno" Boards Manager...

4

N ! Port Arduino AVR Boards

~

& void loop Programmer: "USBtinyISP" Arduine Yiin

7 [ put @ ®  Arduino/Genuino Uno

- Burn Bootloader

ol Arduino Duemilanove or Diecimila

Once the Board Manager opens, click on the category drop down menu on the top left hand side of the
window and select All. You will then be able to select and install the boards supplied by the URLs added to
the preferences.

Remember you need SETUP the Arduino IDE to support our board packages - see the previous page
on how to add adafruit's URL to the preferences

Install SAMD Support

First up, install the latest Arduino SAMD Boards (version 1.6.11 or later)

You can type Arduino SAMD in the top search bar, then when you see the entry, click Install

|| Type al ~ | |Fiter your search...

I o
Arduino SAM Boards (22-bits ARM Cortex-M2) by Arduino version 1.6.6 INSTALLED .
Boards included in this package:

Arduino Due.

Cnline help
More info

mn

Arduino SAMD Boards (22-bits ARM Cortex-M0+) by Arduino
Boards included in this package:

Arduino/Genuino Zero.

Cnline helo

More info

(16.2 » | Instal

Intel i586 Boards by Intel
Boards included in this package:
Galilea.

More info

Install Adafruit SAMD

Next you can install the Adafruit SAMD package to add the board file definitions
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Make sure you have Type All selected to the left of the Filter your search... box

You can type Adafruit SAMD in the top search bar, then when you see the entry, click Install
1B Board: Manages ' (TN

| Type Al - | |Fiter your search...

Boards includad in this packags: i
I Adafruit Flora, Adafruit Gemma BMHz, Adafruit Bluefruit Micro, Adafruit Feather 32u4, Adafruit Metro, Adafruit Pro Trinket

| | sw1emHz (USB), Adafruit Pro Trinket 2v/12MHz (USB), Adafruit Pro Trinket SV/16MHz (FTDI), Adafruit Pro Trinket 3V/12MHz

(FTDI), Adafruit Trinket 8MHz, Adafruit Trinket 16MHz.

Online help

More info

Adafruit SAMD Boards by Adafruit
Boards included in this package:
Adafruit Feather MO.

Online halp

More info

|

m

Leonardo & Micro MIDI-USE (arcore) by Ralf Kistner

Boards included in this package:

Arduino Leonarda (MIDI), Arduino Leonardo (MIDI, iPad compatible), Arduine Micro (MIDI).
Online help —
More info

Even though in theory you don't need to - | recommend rebooting the IDE

Quit and reopen the Arduino IDE to ensure that all of the boards are properly installed. You should now be
able to select and upload to the new boards listed in the Tools->Board menu.

Select the matching board, the current options are:

Feather MO (for use with any Feather MO other than the Express)
Feather MO Express

Metro MO Express

Circuit Playground Express
Gemma MO

Trinket MO

QT Py MO

ItsyBitsy MO

Hallowing MO

Crickit MO (this is for direct programming of the Crickit, which is probably not what you want! For
advanced hacking only)
Metro M4 Express

Grand Central M4 Express
ItsyBitsy M4 Express
Feather M4 Express

Trellis M4 Express
PyPortal M4

PyPortal M4 Titano
PyBadge M4 Express
Metro M4 Airlift Lite
PyGamer M4 Express
MONSTER M4SK
Hallowing M4
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® MatrixPortal M4
® BLM Badge

File Edit Sketch Vﬂp

£¥; Ao requs Board: "Adafruit ItsyBitsy M4 (SAMDS51)"

// Rdafruit_ i

Auto Format Ctrl+ T
Archive Sketch
doubleWide Fix Encoding & Reload

// Example/di| Serial Monitor Ctrl+Shift+M |of & strands

[7 23 8 AISEL i) Plotter Ctri+Shifesl. | FF37¢:

// For more cf A

/¢ included e

A AREIREEE T WiFiLO1 Firmware Updater Adafruit SAMD (32-bits ARM Cortex-M0+ and Cortex-M4) Boards

Adafruit Feather MO
Adafruit Feather MO Express

Port ! Adafruit Metro MO Ex
it Met

/f May Tequir Get Board Info 2 m: o e
i Adafruit Circuit Playground Express
/ or use Neo

Programmer: "USBtinyISP” ! Adafruit Gemma M0
#include <Ada Burn Bootloader Adafruit Trinket M0

Adafruit ItsyBitsy M0

sde i // Per strand. To pbar of pixels i
#define NUM LED &4 // Per strand. Total number of pixels is Adafruit plRkey
// Second argument to constructor is an optional 8-byte pin ] Adafruit Metro M4 (SAMDS1)

Install Drivers (Windows 7 & 8 Only)

When you plug in the board, you'll need to possibly install a driver

Click below to download our Driver Installer

https://adafru.it/ECO

https://adafru.it/ECO
Download and run the installer

-
Cpening adafruit_drivers.exe

You have chosen to open:
=] adafruit_drivers.exe
which is: Binary File (13.6 MB)

Would you like to save this file?

from: https://github-cloud.s3.amazonaws.com

| saveFile | | Cancel |

|

Run the installer! Since we bundle the SiLabs and FTDI drivers as well, you'll need to click through the

license

-
¥ Adafruit Board Dri\rers:i_icense Agreement

Please review the license agreement before installing Adafruit board
drivers. If you accept all terms of the agreement, dick I Agree.

Adafruit by purchasing hardware from:
<http://www.adafruit.com/>

i‘l’his program will allow you to install Windows drivers for ~ +
hardware that Adafruit Industries produces. Please support L

Note you can uninstall any of the installed drivers by using
the Add/Remove Programs option in Control Panel (look for
the "Windows Driver Package' entries from Adafruit).

Cancel | Mullsoft Install System «3.0b3

I Agree

b

Select which drivers you want to install, the defaults will set you up with just about every Adafruit board!
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start the installation.

* Check the board drivers below that you would like to install. Clidk install to

Select board drivers to install:

Feather 32u4, Feather MO, Feather MO Es
Feather WICED

Trinket / Pro Trinket / Gemma {(JSBtinyISP)
[ Arduine Gemma

] Feather HUZZAH ESP8266 (SiLabs CP210x)
[ Metro 328 / Metro Mini 328 (FTDI VCP and

< i »

Cancel | Mullsoft Install System 3,02, 1

Click Install to do the installin'

< Back | Install I

.
¥ Adafruit Board Drivers: Completed ’E@&J

Completed

Show details |

Cancel | tullsaft Install System v3.0b3

< Back

Blink

Now you can upload your first blink sketch!

Plug in the MO or M4 board, and wait for it to be recognized by the OS (just takes a few seconds). It will
create a serial/COM port, you can now select it from the drop-down, it'll even be 'indicated' as
Trinket/Gemma/Metro/Feather/ItsyBitsy/Trellis!

Please note, the QT Py and Trellis M4 Express are two of our very few boards that does not have an
onboard pin 13 LED so you can follow this section to practice uploading but you wont see an LED blink!

_
sketch_nov23a | Arduino 1.6.4

File Edit Sketch Help

sketch_nov23z

wold setup()
J/ put your

}

void loop() {
J/ put your

Auto Format
Archive Sketch
Fix Encoding & Reload

Serial Monitor

Board: "Adafruit Feather..."
Port: "COMS52 (Adafruit ..."

Programmer: "AVRISP mikdl"

Burn Bootloader

" - = | B ]
Ctel+T
Ctrl+Shift+ M i

Serial ports
com
v COMBS2 (Adafruit Feather MO (Mative USE Port))

L
Now load up the Blink example
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// the setup function runs once when you press reset or power the board
void setup() {

// initialize digital pin 13 as an output.

pinMode (13, OUTPUT);
}

// the loop function runs over and over again forever
void loop() {
digitalWrite(13, HIGH); // turn the LED on (HIGH is the voltage level)

delay(1000); // wait for a second
digitalWrite(13, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

}

And click upload! That's it, you will be able to see the LED blink rate change as you adapt the delay() calls.

If you are having issues, make sure you selected the matching Board in the menu that matches the
hardware you have in your hand.

Successful Upload

If you have a successful upload, you'll get a bunch of red text that tells you that the device was found and
it was programmed, verified & reset

Adafruit Feather MO (Native USB Port) on COMSS
=

After uploading, you may see a message saying "Disk Not Ejected Properly" about the ...BOOT drive. You
can ignore that message: it's an artifact of how the bootloader and uploading work.

Compilation Issues

If you get an alert that looks like
Cannot run program "{runtime.tools.arm-none-eabi-gcc.path}\bin\arm-non-eabi-g++"

Make sure you have installed the Arduino SAMD boards package, you need both Arduino & Adafruit
SAMD board packages
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Cannat run pr

{runtime.t

max-inli

0 ow

Q

2]

Adafruit Feather MO ( ive USH Port) on COR11

Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that crashes and doesn't
auto-reboot into the bootloader, click the RST button twice (like a double-click)to get back into the
bootloader.

The red LED will pulse and/or RGB LED will be green, so you know that its in bootloader mode.

Once it is in bootloader mode, you can select the newly created COM/Serial port and re-try uploading.

% <ketch nov27a | Arduine LE.
File Edit Sketch Help

Auto Format Cirl+T £
Archive Sketch
Fix Encoding & Reload
Serial Monitor Ctrl+Shift«M = Doard
Board: "Adafruit Feather M0 (Native USB Port)" 4
Port L Serial ports
COomMl

Programmer: "USBtinyISP" [
comz

COMI129 (Adafruit Feather MO (Mative USB Port))
n the LED on (HIGH is the volvage zovexy

Burn Bootloader

a second

upload.

Ubuntu & Linux Issue Fix

Follow the steps for installing Adafruit's udev rules on this page. (https://adafru.it/iOE)
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Adapting Sketches to MO & M4

The ATSAMD21 and 51 are very nice little chips, but fairly new as Arduino-compatible cores go. Most
sketches & libraries will work but here’s a collection of things we noticed.

The notes below cover a range of Adafruit MO and M4 boards, but not every rule will apply to every board
(e.g. Trinket and Gemma MO do not have ARef, so you can skip the Analog References notel).

Analog References

If you'd like to use the ARef pin for a non-3.3V analog reference, the code to use is
analogReference(AR_EXTERNAL) (it's AR_EXTERNAL not EXTERNAL)

Pin Outputs & Pullups

The old-style way of turning on a pin as an input with a pullup is to use
pinMode(pin, INPUT)
digitalWrite(pin, HIGH)

This is because the pullup-selection register on 8-bit AVR chips is the same as the output-selection
register.
For MO & M4 boards, you can't do this anymore! Instead, use:

pinMode(pin, INPUT_PULLUP)

Code written this way still has the benefit of being backwards compatible with AVR. You don’t need
separate versions for the different board types.

Serial vs SerialUSB

99.9% of your existing Arduino sketches use Serial.print to debug and give output. For the Official Arduino
SAMD/MO core, this goes to the Serial5 port, which isn't exposed on the Feather. The USB port for the
Official Arduino MO core is called SerialUSB instead.

In the Adafruit MO/M4 Core, we fixed it so that Serial goes to USB so it will automatically work just fine .

However, on the off chance you are using the official Arduino SAMD core and notthe Adafruit version
(which really, we recommend you use our version because it’s been tuned to our boards), and you want
your Serial prints and reads to use the USB port, use Seria/lUSB instead of Serialin your sketch.

If you have existing sketches and code and you want them to work with the MO without a huge find-
replace, put

#if defined(ARDUINO_SAMD_ZERO) && defined(SERIAL_PORT_USBVIRTUAL)
/I Required for Serial on Zero based boards
#define Serial SERIAL_PORT_USBVIRTUAL

#endif

right above the first function definition in your code. For example:
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File Edit Sketch Tools Help

datecalc §

1 // S5imple date conversions and calculations

3 #include <Wire.h> 4
l 4 #include "RIClib.h" '

6 #if defined (ARDUINO_ARCH_SAMD)

7 /¢ for Zero, output on USB Serial console, remove line below if using programming port to program the Zero!
8 #define Serial SerialUSB

9 fendif

11 |void showDate {const char* txt, const DateTimes dt) {
Serial.print (tXt):

Serial.print(" ");

AnalogWrite / PWM on Feather/Metro MO

After looking through the SAMD21 datasheet, we've found that some of the options listed in the
multiplexer table don't exist on the specific chip used in the Feather MO.

For all SAMD21 chips, there are two peripherals that can generate PWM signals: The Timer/Counter (TC)
and Timer/Counter for Control Applications (TCC). Each SAMD21 has multiple copies of each, called
'instances'.

Each TC instance has one count register, one control register, and two output channels. Either channel can
be enabled and disabled, and either channel can be inverted. The pins connected to a TC instance can
output identical versions of the same PWM waveform, or complementary waveforms.

Each TCC instance has a single count register, but multiple compare registers and output channels. There
are options for different kinds of waveform, interleaved switching, programmable dead time, and so on.

The biggest members of the SAMD21 family have five TC instances with two 'waveform output' (WO)
channels, and three TCC instances with eight WO channels:

o TC[0-4],WO[0-1]
e TCC[0-2],WO[0-7]

And those are the ones shown in the datasheet's multiplexer tables.

The SAMD21G used in the Feather MO only has three TC instances with two output channels, and three
TCC instances with eight output channels:

® TC[3-5],WO[0-1]
e TCC[0-2],WO[0-7]

Tracing the signals to the pins broken out on the Feather MO, the following pins can't do PWM at all:
® Analog pin A5

The following pins can be configured for PWM without any signal conflicts as long as the SPI, 12C, and
UART pins keep their protocol functions:

® Digital pins 5, 6, 9, 10, 11, 12, and 13
® Analog pins A3 and A4

If only the SPI pins keep their protocol functions, you can also do PWM on the following pins:

® TX and SDA (Digital pins 1and 20)
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analogWrite() PWM range
On AVR, if you set a pin's PWM with analogWrite(pin, 255) it will turn the pin fully HIGH. On the ARM cortex,
it will set it to be 255/256 so there will be very slim but still-existing pulses-to-OV. If you need the pin to be

fully on, add test code that checks if you are trying to analogWrite(pin, 255) and, instead, does a
digitalWrite(pin, HIGH)

analogWrite() DAC on AO

If you are trying to use analogWrite() to control the DAC output on AO, make sure you do not have a line
that sets the pin to output. Remove: pinMode(A0, OUTPUT) .

Missing header files
There might be code that uses libraries that are not supported by the MO core. For example if you have a
line with

#include <util/delay.h>

you'll get an error that says

fatal error: util/delay.h: No such file or directory
#include <util/delay.h>
A
compilation terminated.
Error compiling.

In which case you can simply locate where the line is (the error will give you the file name and line
number) and 'wrap it' with #ifdef's so it looks like:

#if !defined (ARDUINO ARCH SAM) && !defined(ARDUINO ARCH SAMD) && !defined(ESP8266) && !'defined(ARDUINO ARCH STM32F
)

#include <util/delay.h>

#endif

1 [T

The above will also make sure that header file isn't included for other architectures

If the #include is in the arduino sketch itself, you can try just removing the line.

Bootloader Launching

For most other AVRs, clicking reset while plugged into USB will launch the bootloader manually, the
bootloader will time out after a few seconds. For the MO/M4, you'll need to double click the button. You
will see a pulsing red LED to let you know you're in bootloader mode. Once in that mode, it wont time out!
Click reset again if you want to go back to launching code.

Aligned Memory Access

This is a little less likely to happen to you but it happened to me! If you're used to 8-bit platforms, you can
do this nice thing where you can typecast variables around. e.g.

uint8_t mybuffer[4];
float f = (float)mybuffer;

You can't be guaranteed that this will work on a 32-bit platform because mybuffer might not be aligned to
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a 2 or 4-byte boundary. The ARM Cortex-MO can only directly access data on 16-bit boundaries (every 2 or
4 bytes). Trying to access an odd-boundary byte (on a 1 or 3 byte location) will cause a Hard Fault and stop
the MCU. Thankfully, there's an easy work around ... just use memcpy!

uint8_t mybuffer[4];
float f;
memcpy (&f, mybuffer, 4)

Floating Point Conversion

Like the AVR Arduinos, the MO library does not have full support for converting floating point numbers to
ASCII strings. Functions like sprintf will not convert floating point. Fortunately, the standard AVR-LIBC
library includes the dtostrf function which can handle the conversion for you.

Unfortunately, the MO run-time library does not have dtostrf. You may see some references to using
#include <avr/dtostrf.h> to get dtostrf in your code. And while it will compile, it does not work.

Instead, check out this thread to find a working dtostrf function you can include in your code:
http://forum.arduino.cc/index.php?topic=368720.0 (https://adafru.it/IFS)

How Much RAM Available?

The ATSAMD21G18 has 32K of RAM, but you still might need to track it for some reason. You can do so
with this handy function:
extern "C" char *sbrk(int 1i);

int FreeRam () {

char stack dummy = 0;

return &stack _dummy - sbrk(0);
}

Thx to http://forum.arduino.cc/index.php?topic=365830.msg2542879#msg2542879 (https://adafru.it/m6D)
for the tip!

Storing data in FLASH

If you're used to AVR, you've probably used PROGMEM to let the compiler know you'd like to put a
variable or string in flash memory to save on RAM. On the ARM, its a little easier, simply add const before
the variable name:

const char str[] = "My very long string";

That string is now in FLASH. You can manipulate the string just like RAM data, the compiler will
automatically read from FLASH so you dont need special progmem-knowledgeable functions.

You can verify where data is stored by printing out the address:
Serial.print("Address of str $"); Serial.printin((int)&str, HEX);

If the address is $2000000 or larger, its in SRAM. If the address is between $0000 and $3FFFF Then it is
in FLASH

Pretty-Printing out registers

There's a /ot of registers on the SAMD21, and you often are going through ASF or another framework to
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get to them. So having a way to see exactly what's going on is handy. This library from drewfish will help a
ton!

https://github.com/drewfish/arduino-ZeroRegs (https://adafru.it/Bet)

M4 Performance Options
As of version 1.4.0 of the Adafruit SAMD Boards package in the Arduino Boards Manager, some options
are available to wring extra performance out of M4-based devices. These are in the Tools menu.

Sketch BGLIEE Help

CPU Speed: "200 MHz (overclock)"

v 200 MHz (overclock)

All of these performance tweaks involve a degree of uncertainty. There’s no guarantee of improved
performance in any given project, and some may even be detrimental, failing to work in part or in whole. If
you encounter trouble, select the default performance settings and re-upload.

Here’s what you get and some issues you might encounter...

CPU Speed (overclocking)

This option lets you adjust the microcontroller core clock...the speed at which it processes instructions...
beyond the official datasheet specifications.

Manufacturers often rate speeds conservatively because such devices are marketed for harsh industrial
environments...if a system crashes, someone could lose a limb or worse. But most creative tasks are less
critical and operate in more comfortable settings, and we can push things a bit if we want more speed.

There is a small but nonzero chance of code locking up or failing to run entirely. If this happens, try dialing
back the speed by one notch and re-upload, see if it's more stable.

Much more likely, some code or libraries may not play well with the nonstandard CPU speed. For
example, currently the NeoPixel library assumes a 120 MHz CPU speed and won’t issue the correct data at
other settings (this will be worked on). Other libraries may exhibit similar problems, usually anything that
strictly depends on CPU timing...you might encounter problems with audio- or servo-related code
depending how it’s written. If you encounter such code or libraries, set the CPU speed to the default 120
MHz and re-upload.

Optimize

There’s usually more than one way to solve a problem, some more resource-intensive than others. Since
Arduino got its start on resource-limited AVR microcontrollers, the C++ compiler has always aimed for the
smallest compiled program size. The “Optimize” menu gives some choices for the compiler to take
different and often faster approaches, at the expense of slightly larger program size...with the huge flash
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memory capacity of M4 devices, that’s rarely a problem now.

The “Small” setting will compile your code like it always has in the past, aiming for the smallest compiled
program size.

The “Fast” setting invokes various speed optimizations. The resulting program should produce the same
results, is slightly larger, and usually (but not always) noticably faster. It’s worth a shot!

“Here be dragons” invokes some more intensive optimizations...code will be larger still, faster still, but
there’s a possibility these optimizations could cause unexpected behaviors. Some code may not work the
same as before. Hence the name. Maybe you’ll discover treasure here, or maybe you’ll sail right off the
edge of the world.

Most code and libraries will continue to function regardless of the optimizer settings. If you do encounter
problems, dial it back one notch and re-upload.

Cache

This option allows a small collection of instructions and data to be accessed more quickly than from flash
memory, boosting performance. It's enabled by default and should work fine with all code and libraries. But
if you encounter some esoteric situation, the cache can be disabled, then recompile and upload.

Max SPI and Max QSPI
These should probably be left at their defaults. They’re present mostly for our own experiments and can
cause serious headaches.

Max SPI determines the clock source for the M4’s SPI peripherals. Under normal circumstances this allows
transfers up to 24 MHz, and should usually be left at that setting. But...if you’re using write-only SPI devices
(such as TFT or OLED displays), this option lets you drive them faster (we’ve successfully used 60 MHz
with some TFT screens). The caveat is, if using any read/write devices (such as an SD card), this will not
work at all...SPI reads absolutely max out at the default 24 MHz setting, and anything else will fail. Write =
OK. Read = FAIL. This is true even if your code is using a lower bitrate setting... just having the different
clock source prevents SPI reads.

Max QSPI does similarly for the extra flash storage on M4 “Express” boards. Very few Arduino sketches
access this storage at all, let alone in a bandwidth-constrained context, so this will benefit next to nobody.
Additionally, due to the way clock dividers are selected, this will only provide some benefit when certain
“CPU Speed” settings are active. Our PyPortal Animated GIF Display (https://adafru.it/EkO) runs marginally
better with it, if using the QSPI flash.

Enabling the Buck Converter on some M4 Boards

If you want to reduce power draw, some of our boards have an inductor so you can use the 1.8V buck
converter instead of the built in linear regulator. If the board does have an inductor (see the schematic)
you can add the line SUPC->VREG.bit.SEL = 1; to your code to switch to it. Note it will make ADC/DAC

reads a bit noisier so we don't use it by default. You'll save “4mA (https://adafru.it/FOH).
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Feather HELP!

Even though this FAQ is labeled for Feather, the questions apply to ItsyBitsy's as well!

My ItsyBitsy/Feather stopped working when | unplugged the USB!

A lot of our example sketches have a

while (!Serial);

line in setup(), to keep the board waiting until the USB is opened. This makes it a lot easier to debug a
program because you get to see all the USB data output. If you want to run your Feather without USB
connectivity, delete or comment out that line

My Feather never shows up as a COM or Serial port in the Arduino IDE
A vast number of Itsy/Feather 'failures' are due to charge-only USB cables

We get upwards of 5 complaints a day that turn out to be due to charge-only cables!
Use only a cable that you know is for data syncing

If you have any charge-only cables, cut them in half throw them out. We are serious! They tend to be low
quality in general, and will only confuse you and others later, just get a good data+charge USB cable.

A quality USB port is critical. Avoid plugging into USB keyboards and when possible use a USB-2 HUB to
avoid USB3 issues.

Ack! | "did something" and now when | plug in the Itsy/Feather, it
doesn't show up as a device anymore so | cant upload to it or fix it...
No problem! You can 'repair' a bad code upload easily. Note that this can happen if you set a watchdog
timer or sleep mode that stops USB, or any sketch that 'crashes' your board

1. Turn on verbose upload in the Arduino IDE preferences

2. Plugin Itsy or Feather 32u4/MO, it won't show up as a COM/serial port that's ok

3. Open up the Blink example (Examples->Basics->Blink)

4. Select the correct board in the Tools menu, e.g. Feather 32u4, Feather MO, Itsy 32u4 or MO

(physically check your board to make sure you have the right one selected!)

Compile it (make sure that works)

Click Upload to attempt to upload the code

7. The IDE will print out a bunch of COM Ports as it tries to upload. During this time, double-click the
reset button, you'll see the red pulsing LED that tells you its now in bootloading mode

8. The board will show up as the Bootloader COM/Serial port

9. The IDE should see the bootloader COM/Serial port and upload properly

o o
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Blink | Arduino 1.6.5 =NNCE X
File Edit Sketch Tools Help

ables. Maximum

Arduing Leenarde on COM12Z

| can't get the Itsy/Feather USB device to show up - | get "USB Device

Malfunctioning" errors!
This seems to happen when people select the wrong board from the Arduino Boards menu.

If you have a Feather 32u4 (look on the board to read what it is you have) Make sure you select Feather
32u4 for ATMega32u4 based boards! Do not use anything else, do not use the 32u4 breakout board line.

If you have a Feather MO (look on the board to read what it is you have) Make sure you select Feather MO
- do not use 32u4 or Arduino Zero

If you have a ltsyBitsy MO (look on the board to read what it is you have) Make sure you select ltsyBitsy
MO - do not use 32u4 or Arduino Zero

I'm having problems with COM ports and my Itsy/Feather 32u4/MO

Theres two COM ports you can have with the 32u4/MO, one is the user port and one is the bootloader
port. They are not the same COM port number!

When you upload a new user program it will come up with a user com port, particularly if you use Serial in
your user program.
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If you crash your user program, or have a program that halts or otherwise fails, the user COM port can
disappear.

When the user COM port disappears, Arduino will not be able to automatically start the bootloader and
upload new software.

So you will need to help it by performing the click-during upload procedure to re-start the bootloader, and
upload something that is known working like "Blink"

| don't understand why the COM port disappears, this does not happen

on my Arduino UNO!
UNO-type Arduinos have a seperate serial port chip (aka "FTDI chip" or "Prolific PL2303" etc etc) which

handles all serial port capability seperately than the main chip. This way if the main chip fails, you can
always use the COM port.

MO and 32u4-based Arduinos do not have a seperate chip, instead the main processor performs this task
for you. It allows for a lower cost, higher power setup...but requires a little more effort since you will need
to 'kick' into the bootloader manually once in a while

I'm trying to upload to my 32u4, getting "avrdude: butterfly_recv():

programmer is not responding" errors
This is likely because the bootloader is not kicking in and you are accidentally trying to upload to the

wrong COM port

The best solution is what is detailed above: manually upload Blink or a similar working sketch by hand by
manually launching the bootloader

I'm trying to upload to my Feather MO, and | get this error "Connecting
to programmer: .avrdude: butterfly_recv(): programmer is not
responding”

You probably don't have Feather MO selected in the boards drop-down. Make sure you selected Feather
MO.

I'm trying to upload to my Feather and i get this error "avrdude:

ser_recv(): programmer is not responding"
You probably don't have Feather MO / Feather 32u4 selected in the boards drop-down. Make sure you

selected Feather MO (or Feather 32u4).

| attached some wings to my Feather and now | can't read the battery

voltage!
Make sure your Wing doesn't use pin #9 which is the analog sense for the lipo battery!
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The yellow LED Is flickering on my Feather, but no battery is plugged
in, why is that?

The charge LED is automatically driven by the Lipoly charger circuit. It will try to detect a battery and is
expecting one to be attached. If there isn't one it may flicker once in a while when you use power because
it's trying to charge a (non-existant) battery.

It's not harmful, and its totally normal!
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Downloads
Datasheets

e ATSAMD?21 Datasheet (https://adafru.it/kUf) (the main chip on the Feather MO)
® Fritzing object in the Adafruit Fritzing Library (https://adafru.it/aP3)
® FEagleCAD PCB files in GitHub (https://adafru.it/kFh)

https://adafru.it/z3f

https://adafru.it/z3f
Note AREF in the diagram should be marked PAO3 not PAOZ2

Firmware
Feather MO Bootloader - You'll need to program it in using an ST-Link, JLink or other SWD-capable
programmer. HEX available in the github repo (https://adafru.it/kFh)

https://adafru.it/BuO
https://adafru.it/BuO

Schematic
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https://www.adafruit.com/images/product-files/2772/atmel-42181-sam-d21_datasheet.pdf
https://github.com/adafruit/Fritzing-Library
https://github.com/adafruit/Adafruit-Feather-M0-Basic-Proto-PCB
https://cdn-learn.adafruit.com/assets/assets/000/046/196/original/Feather_M0_Basic_Proto_v2.2.pdf?1504805559
https://github.com/adafruit/Adafruit-Feather-M0-Basic-Proto-PCB
https://cdn-learn.adafruit.com/assets/assets/000/054/998/original/pid_2772_circuitpy_2.3.1_files.zip?1528154191
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